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QuickBooks Desktop Foundations

QuickBooks® QuickBooks Desktop Foundations

It is important to focus on the areas of our business that contribute most to profitability. 

QuickBooks helps us easily identify areas of focus if we know where to look.

The 80/20 rule, or the ‘Pareto Principle’, is a powerful concept that consistently rings true.

In most cases, 20% of our customers generate 80% of our net profit.  At the same time, 

20% of the goods or services we sell contribute 80% of our revenue, etc. You get the idea.

The most important value good bookkeeping brings to a business is an understanding of 

where to focus.

By generating daily reports that uncover the best customers, jobs, services, or products, 

you will soon see how you can refocus your internal efforts on doing highly valuable work.

Accurate real-time data with one click reports, is an enormous benefit of using 

QuickBooks® the ‘right-way’.
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Section 2 Objectives

Upon completion of section 2 each participant will become familiar with the following 

objectives:

• How to turn on/off preferences or settings for both user and company.  

• How preferences are used as default settings and how they effect the 

company data file.

• How to setup and manage users.

• How to set up and utilize the Chart of Accounts and how it connects to all 

transactions.

• How to use the Sales Tax center and where to turn on the feature.

• How to setup and maintain items. 

• The best practice approach to entering beginning balances, outstanding 

invoices, and unpaid bills when setting up a new company file.
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Company Set-up is Vital

An accurate QuickBooks configuration is essential to effectively using the accounting 

system. The initial set up will affect all future reports in QuickBooks. This is why we 

recommend you practice a company set-up from scratch.

QuickBooks is a very forgiving program. Most mistakes can be fixed as you have the ability 

to go back and make historical changes, however a correct setup will prevent the need in 

most cases. 

Here are some questions for you to consider:

Do you need all historical transactions entered or can you just use correct 

opening balances for all accounts to date and enter new transactions going 

forward?

If you currently use the software, do you trust the accuracy of information in 

your QuickBooks® file?
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Accounting Preferences

Classes are used to assign transactions to different divisions or track information by a 

specific class category.

For example:  ABC company has several departments and would like to view a Profit & Loss  

report for each individual department. 

Click the appropriate box to turn on Use Class Tracking. Then click Prompt to Assign 

Classes, which will create an alert when the class field is missed during the data entry 

process. 

Automatically Assign General Journal Entry Number tells QuickBooks® to auto populate a 

reference number for all general journal entries.   

Transaction Warnings are selected to prevent data entry errors. Turn off days in the past 
when entering historical data, then turn it back on when your data is current.

Closing Date and Password are used to prevent users from changing historical data and is 
highly recommended.
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Checking Preferences

Checking: My Preferences 

Default Accounts – Each user can select default account for Write Checks, Pay Bills, Pay 

Sales Tax and Make Deposits transactions.

Creating efficiencies and reducing errors while entering transactions is another way to 

improve cash flow as you will spend less on data entry time and mistakes.
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Desktop View

Desktop View:  Company Preferences

Home Page Features - turning on features in the Desktop View will trigger icons on the 
Home Page.

Turn on Sales Receipts if you need to record sales after the fact.

Statements are useful for managing your Accounts Receivable and reminding customers of 
balances past due.

Clicking Related Preferences will take you to the preference window also available in the 
preference list.

10



QuickBooks Desktop Foundations

General Preferences

General: Company Preferences

Time Format allows you to change default settings from Decimal to Minutes when 
entering time transactions.

Save Transactions before Printing is a good way to make sure you do not lose information 
when printing directly from an entry window.

Manage Login Settings allows you to determine how long users can be logged in. Many 
users forget to logout when they go to lunch or take a break. Logging out helps to reset 
computer resources being used by QuickBooks® and helps to keep your data file more 
secure.

Note:  Logging off every time a user closes the company file or exits QuickBooks® could be 
useful for those working in multi-user mode.  
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Integrated Applications

Integrated Applications: Company Preferences

Many companies have developed add-on products that work with QuickBooks®. You can 
allow the integration from the Company tab.

You can log into the Intuit App Center to find out if any of your favorite software integrates 
with QuickBooks®.
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Payments

Payments: Company Preferences

Receive Payments are default settings used when receiving payments from customers. 

Automatically Apply Payments if you want invoices to be checked oldest to latest when 

receiving a payment from a customer.  

Automatically Calculate Payments will calculate the total received as you check off 

invoices.

Undeposited Funds is a very important preference that allows you to group payments 

when recording a deposit.  

Online Payments allows your customers to pay invoices online. You will be prompted to 

setup an account with Intuit’s Payment Network and make the payment method active in 

the Payment Method List.
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Reports & Graphs Preferences

Reports & Graphs: Company Preferences

Here you will need to determine if you would like your reports to default to the Accrual or 
Cash basis. This is a default setting that can be changed on the fly when viewing financial 
reports.

If you invoice customers and maintain Accounts Receivable then it is recommended you 
view reports on both the Accrual and Cash basis.

Aging Reports gives you the option to Age from due date or Age from transaction date.  
This will impact the A/R Aging Reports.

Report preferences for Items and Accounts will determine how they are displayed on the 
reports.  

Statement of Cash Flows will require setup to determine which accounts will be viewed on 
a Cash Flow Statement.

Default Formatting is used to customize reports such as Headers/Footers and 
Fonts/Numbers.
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Sales Tax Preferences

Sales Tax: Company Preferences

Turning on Sales Tax will require you to add and maintain Sales Tax Items. You can add an 

item for each individual county and respective percentage. The tax is calculated when 

entering Sales Receipts and Invoices.  

Assign Sales Tax Codes are default codes used when setting up product or service items.

When you Owe Sales Tax is based on your state’s filing requirements.

When you Pay Sales Tax is also based on your state filing requirements.
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Send Forms Preference

Send Forms: My Preferences

To send invoices and reports via email, each user will need to setup their own Email Info.

Select Auto-Check the Email Later box to automatically flag invoices to send later. This 

feature requires you to add the E-Mail: Preferred Delivery Method in each customer’s 

profile.

Click the Add button and enter the Email ID.

Choose an Email Provider from the drop down list. If your provider is not listed you will 

need to locate the SMTP Server Details and enter them here.  

When you click Use enhanced security you will be required to enter your Intuit ID and 

allow Intuit to connect to your email provider.
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The Big Picture  of Why this Training is Important
The bookkeeping function is a critical component of business success.

The majority of business owners do not recognize the value of good numbers or how to put 

them to work to improve company performance. Accurate, real-time financial data is 

powerful.

QuickBooks is designed to help you with every day organization, from organizing expenses, 

connecting bank and credit card accounts for automatic downloads, to categorization and 

far more. As we will demonstrate, the software automatically tracks inventory on hand and 

per item cost so you can keep a better handle on productivity and profit margins, etc. In 

addition, it provides real-time data with one click reporting that explains how the business 

is performing.

QuickBooks can help a business control cash flow. The software automatically stays on top 

of who owes what, and will even email overdue customers. Automated invoicing and more, 

will streamline processes, dropping more to the bottom line. 

As you can see, learning how to take advantage of important features of accounting 

software can mean the difference between success and failure in a business. 
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Manage Users

Users with Limited Permissions or Access 

Click Add User from the User List window. Enter the User Name, Password and Confirm 

Password. Click Next.

You will need to select the level of access for the new user;  All Areas or Selected Areas.

The External Accountant works well for your accountant as it provides more access without 

the ability to view credit card numbers. Select All Areas of QuickBooks and click Next. A 

Warning dialog box will appear and ask you to confirm this request. Click Yes.
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Manage Users

Restricted Access

Choose Selected areas of QuickBooks® and click Next.  A window will appear for all areas 

that pertain to your company file and will require you to choose between No Access, Full 

Access or Selective Access. No Access was selected for Sales and Accounts Receivable. 

Click Next.  choose an option for Purchases and Accounts Payable and click Next.
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Manage Users

Choose options for Checking and Credit Cards, Payroll and Employees. Click Next for each 

window that appears. Remember the windows that appear are specific to your company 

file.

Choose options for Sensitive Accounting Activities and Sensitive Financial Reporting.

Click Next.
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Chart of Accounts

The Chart of Accounts is a list of categories that make up your Balance Sheet and 

Profit & Loss Statements. Every transaction entered into QuickBooks® will post to this 

accounts list. This is how data is compiled to produce important reports you will use to 

manage your business. 

Balance Sheet

Assets (What your company owns ) - Bank Accounts, Petty Cash, Fixed Assets (Equipment 

or Vehicles), Inventory, Undeposited Funds (Payments from customers waiting to be 

deposited).

Liabilities (What your company owes) - Accounts Payable, Loans, Sales and Payroll Taxes.

Equity (The net worth of your company) = Assets - Liabilities

Money owners contribute or draw from the business and an accumulation of net profits 

and losses from the start of the business to present or sale.

Profit & Loss

Income (What you have earned) - Sales of Products, Labor, Interest, Rental Income, 

Materials, etc.

Expense (What you have spent) - Office Expenses, Wages, Professional Fees, Rent, Utilities, 

etc.

The Profit & Loss Statement determines the net loss or gain for a period of time. At the end 

of a calendar or fiscal year the net profit or loss rolls into the equity section of the Balance 

Sheet.

Note: Keep your chart of accounts simple. Add new accounts when you need to track 

specific information. Utilize reports to customize information within an account. Discuss 

account changes with your accountant. Start by adding Bank and Credit Card Accounts. 
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Chart of Accounts

There are several ways to access the Chart of Accounts list.  

The Menu Bar, Home Page or Icon Bar.  

Click Home -> Chart of Accounts in the 

Company Section.

Right Click in the body of the Chart of Accounts -> Customize Columns. 

You can choose which columns are displayed in the account list.

When you sort your Chart of Accounts by Type, the top half is the Balance Sheet (Assets, 

Liabilities and Equity) and the bottom half is the Profit & Loss (Income and Expenses).
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Chart of Accounts

If account numbers are turned on in the accounting preferences, enter 99999 for the 

account Number and Ask My Accountant for the Account Name.

Description and Notes are optional fields.

By using the Tax-Line Mapping, you can Link the Tax Line to an item on your tax form, 

which  will allow for easy downloads to TurboTax®.  

Select Track Reimbursed Expenses in Income if you want to post all transactions related to 

this expense account to a specific income account.

Click Save & Close. This account will now appear in your Chart of Accounts List.

Note: Ask My Accountant is an account used for transactions when we are uncertain 

where to post them. Send your accountant a list of transactions in Ask My Accountant for 

clarification. This is a great way to avoid mistakes and learn about categorizing transactions.
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Chart of Accounts

Delete Account

Click one time to highlight the Account you would like to delete.

Click the Account Tab from the Chart of Accounts List.

Click Delete Account.

For this example we will delete Miscellaneous expense.

An Alert will pop up and ask you to confirm. Click OK. If there are historical transactions for 

this account a message will appear. Click Make Inactive to remove the account from 

the account list.
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Chart of Accounts

Merge Accounts

Merging accounts is helpful if two or more accounts are being used for the same types of 

transactions and you want to combine the transactions into a single account.

Caution: The merge process cannot be undone and is permanent. It is important to confirm 

the merge process will not affect the financial statements used to file tax returns. 

It is advisable to discuss the clean up of your Chart of Accounts with your accountant or 

business advisor before merging accounts.

In this example we have two accounts being used to track office expenses.

We will merge Office Supplies with Office Expenses.

from the Chart of Accounts Settings Window.

Click one time to highlight the Account you will keep Office Expense.

Click the Account Tab or Right Click on the screen.

Click Edit.
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Chart of Accounts

Highlight the Name Office Expenses-> Copy (Ctrl + C) the account name. Click the Cancel 

button in lower right  to return to the Chart of Accounts List.

Highlight the Name Office Supplies->Edit->paste (Ctrl + V) to replace Office Supplies with 

Office Expense then click Save. Click Yes.

Sub Accounts are a great way to organize your chart of accounts when used properly.

It is important to select the sub-accounts in all transactions and avoid using the main 

account. For this example we will create three Sub-Accounts for “Auto and Truck Expense.”

Click the Account Tab 

from the Chart of Accounts 

List. Click New.  

Select Account Type 

“Expense.”

Click Continue.
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Manage Sales Tax

Managing sales tax will increase the accuracy of data for state filing.

View sales tax activity, pay sales tax, access reports, edit settings and rates from one 

window. 

Click Vendors from the Menu Bar -> Sales Tax -> Manage Sales Tax.

Adjust Sales Tax Preferences, Review Reports and Review Items and Code Lists.

Note: Invoices or Sales Receipts are required to properly calculate sales tax collected. It is 

important to verify the Sales Tax Liability and Sales Tax Revenue reports before filing with 

your state agency. You are required to manually maintain all sales tax rates in QuickBooks®. 
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Manage Sales Tax

Click the Pay Sales Tax button to write and/or print a sales tax liability check. It is important 

to pay your sales tax liabilities through this window as it maintains proper balances within 

QuickBooks®.
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Items

Add Product or Service

Click the Item tab.

Click New.

Select the Item Type from 

the drop-down list. For this example

we choose “Service”.

Enter the Item Name/Number.

Enter a Description that will 

auto-populate in the Sales Receipt 

of Invoice, you can always change 

or add to the description during 

the entry process.

Enter a default Rate.

Select the default Tax Code for the item.

Select the default Account from the drop-down account list.  Click OK.
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Items

Items can be setup for both purchases and sales. For this example we have added a Non-

Inventory Part and will track the cost and sales of this item without adding it to inventory.

Select the box This item is used in assemblies or is purchased for a specific customer:job.

Enter the default Purchase Information (Cost, Description and Expense Account). This is 

especially important when tracking inventory or using items in bills and checks.

Enter the default Sales Information (Description, Sales Price, Tax Code and Income 

Account).  

Note: Descriptions auto-populate when item is used in an invoice, sales receipt, bill, or 

check.
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Beginning Balances

It is important to verify or enter beginning balances and historical data. Your accountant 

can assist you in using a journal entry or you can add beginning balances when you add 

accounts to your chart of accounts list. Enter beginning balances when setting up a new 

bank account, credit card and other assets/liabilities. In this example a new bank account 

was added with a beginning balance of $5,000.00. The beginning balance is posted to the 

bank register as a debit and a default account referred to as Opening Balance Equity is 

credited. From the Chart of Accounts List, right click in the body of the list -> New. Add 

Account Type Bank then click Enter Opening Balance.

Enter the Statement Ending Balance and Statement Ending Date.

Click OK.  Click Save & Close.
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Historical Transactions

Bank Transactions – If you are entering historical transactions for more than a one-month 

time frame, enter the transactions one month at a time and reconcile all bank and credit 

card accounts before going on to the next month.

There are two ways to enter historical bank transactions; manually and through the bank 

feed center.

Use the following process to enter bank transactions:

1) Manually enter all checks and debits – Home Page (Banking Section) ->  Write Check

and enter all checks posted, one month at a time.

2) Web Connect the bank account to QuickBooks®   – Menu Bar -> Banking -> Bank 

Feeds-> Setup Bank Feed for an Account and follow the setup process. Use caution 

when selecting the period of time to download transactions to avoid duplicate 

transactions.

3) Complete Bank Reconciliation – Home Page (Banking Section) -> Reconcile.  
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Section 2 Practice Test

1. Which of the following statements is true about items?

a) Items are unnecessary.
b) Items replace the chart of accounts.
c) Items are used when creating invoices or sales receipts.
d) All of the above

2. How would you set a closing date and password?

a) Company->Set Closing Date
b) Edit->Preferences->Accounting->Company
c) Both A and B
d) File->Utilities

3. What type of account would you use to setup a new vehicle loan?

a) Long Term Liability
b) Asset
c) Current Liability
d) Expense

4. What item type would you use for tracking sales for products or services you do not 

keep in inventory?

a) Service
b) Non-Inventory
c) Other Charge
d) Inventory

5. What should you do when you need to delete an account and it has historical data?

a) Copy
b) Merge
c) Inactivate
d) Delete
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Section 2 Practice Test

6. Where would you go to setup an external accountant?

a) Company->Setup Users & Passwords->Setup Users
b) Edit-Preferences->General
c) Home Page->Company->Chart of Accounts
d) None of the Above

7. Where can you change the window display from one window to multiple windows?

a) Edit Preferences->Desktop View->My Preferences
b) Lists ->Templates
c) View
d) Both A and C

8. What is the purpose of subaccounts?

a) To track classes or departments.
b) To group accounts in a logical order. 
c) To track expenses by location.
d) None of the above

9. Where would you go to manage sales tax?

a) Customers->Sales Tax->Manage Sales Tax
b) Home Page->Manage Sales Tax
c) Vendors->Sales Tax->Manage Sales Tax
d) Both B and C

10. What category in the chart of accounts is used to post beginning balances?

a) Open Balance Equity
b) Retained Earnings
c) Ask My Accountant
d) Beginning Balances
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Restore a Data File

In this restore example we are replacing an existing data file.   

Click Yes.

When replacing an existing data file you will be asked if you are certain you want to 

permanently delete the file. 

Type YES.

Click OK.

Your data has been successfully restored.

Click OK. 
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Verify and Rebuild Data

When you begin to notice that something appears off in your QuickBooks® data file or your 

balance sheet does not balance, it is time to run a verify and rebuild.

Click File from the Menu Bar.

Click Utilities.

Click Verify Data.

Allow the verify process to complete.  No problems with your data means you can continue 

working.  Click OK.

Note: If you receive a window box that indicates QuickBooks® detected a problem with 

your data, you will need to run a rebuild.
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Glossary of Terms

Accounting and Reporting

https://community.intuit.com/articles/1164870-glossary-of-terms-accounting-and-reporting

Income – Money earned from sale of your products or services is recorded as income.

Expense – An account that tracks and categorizes what your company is spending.

Cost of Goods Sold – The Cost of Goods Sold account is for costs directly related to 

producing a service or product for sale.

Asset – Assets include something you have purchased in the past that will be used in the 

future to produce income. 

Bank – Bank accounts are used to track cash moving in and out of the business.

Other Current Asset – This account type is typically used for Inventory, undeposited Funds, 

Employee Advances etc.

Fixed Asset – Used to track tangible property that will have a useful life of longer than one 

year.

Other Assets – Intangible assets that have life of more than one year and is not a Fixed 

Asset or Current Asset.

Liability – Liabilities are your company’s debts.  

Current Liabilities – Debts your company expects to pay within a year.  Ex. Sales Tax, Payroll 

Tax, Credit Cards.

Long-Term Liabilities – Debts your company expects to pay off in more than one year.  Also 

referred to as Note Payable.

Equity – Equity is the net work of a company.  This is the difference between what you owe 

(liabilities) and what you have (assets).
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